TUTORIAL SERIES FOR
Mastercam, ;{

TUTORIAL 10
NET SURFACE, ROUGH POCKET AND FINISH BLEND
TOOLPATHS.
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Mastercam.

Mill X? TUTORIAL 10'

Objectives:

The Student will design a 3-dimensional drawing by:

» Creating an arc knowing center point, angles and the radius in the Top C-plane.
» Rotating the arc in the Side C-plane.

» Creating two arcs in the Side C-plane at a given distance, knowing 3 points.

> Creating a net surface.

» Changing the view of the part for better visualisation.

The Student will create a 3-dimensional milling toolpath consisting of:

» A 3-dimensional rough toolpath.
» A 3-dimensional finish toolpath.

The Student will check the toolpath using Mastercam’s Verify module by:

> Defining a 3-dimensional cylindrical block, the size of the workpiece
» Running the Verify function to machine the part on the screen.
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GEOMETRY CREATION

To start a new file from Mastercam:

File

> New

¢* Before starting the geometry creation we should customize the toolbars to see the toolbars
required to create the geometry and machine a 2D part. See Getting started page A-5 in
the User Notes.

é“ Toolpaths/Solids operations manager to the left of the screen can be hidden to gain more
space in the graphic area for design. Press Alt + O to remove it.

¢ Before starting the geometry make sure that the Grid is enabled. It will show you at each
moment where the part origin is. See Getting started page A-5 for details.

o

=

STEP 1:

CREATE THE 10” RADIUS ARCS.
1.1 Create an arc knowing the center point, the initial and final angle,
and the radius.

Create
> Arc
» Create Arc Polar

> [ Enter the center point ]: Select the Fast Point icon.
> Enter into the box to the left of the icon : 0, 9.5 (Enter).

©
> Enter the Radius =i 10.

6" To set the other parameters of the arc use the Tah key. Note that the diameter value is
automatically changed by the system based on the radius.

» Enter the Start Angle 5 270-45/2 (Tab).
> Enter the End Angle [ 270+45/2 (Enter).

> Select the OK button. B

> Select the Fit icon to fit the
geometry to the screen.

» The arc should look as shown to Sl
the right. ?
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1.2 Creating two vertical construction lines in the Top Construction
plane.

Create
» Line
> Create Line Endpoints

> Select the Vertical icon.

> [ Specify the first endpoint ]: Pick Point 1 as
shown (sketch the points).

> [ Specify the second endpoint ]: Pick Point 2

0.5

> [ Enter the X coordinate J: f

Point 2 e—

R =
> Select the Apply button. Point 3 ——

> [ Specify the first endpoint ]: Select Point 3 as

shown \ Srg /
> [ Specify the second endpoint ]: Select Point 4

> [ Enter the X coordinate ]: ! E

Point 4 T

> Select the OK button. (.1

1.3 Break the arc at the

intersections with the two vertical
construction lines.

Edit
> Trim/Break
> Break at Intersection

> [ Select entities to break ]: Select the arc

7
and the two lines. Selie‘ct all /
entities

> Select the End Selection button.
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1.4 Delete the 4 construction lines.
> Select the lines as shown in the picture.

A

> Select the Delete entity icon. 4

Select these
lines

1.5 Change the G-view to Isometric
and the construction plane to right side.

» Select the Isometric View from the view toolbar to see the arc

> Click on the drop-down arrow next to the Set planes icon, and select B Top (4icS)
Right .

b

B Front(wes)

1.6 Rotate-Move the arc.

Xform

» Xform Rotate

> [ Rotate: select entities to rotate ]: Select all three arcs.
» Click on the End Selection /
QIR @) Select all arcs —

End Selection

Move  Copy Jain
&, o0
; 1k

® s beliaesn

> Make sure that you make all the changes as shown in the
screenshot.

3 . in : (paint) of rotation
Select Define center. I

» Enable the Move radio button.
» Change the Angle to 14 degrees.
> Select Define center (point) of rotation as shown.

> [ Select the point to rotate about ]: Select the Fast Point icon. i

Freyiew

> Enter into the box to the left of the icon: 0.2612,0 (Enter). =
;_ égi:);f:;ewl\lfti;.ms

(LG
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> If the Preview is active you should be able to see the
result.

> Select the OK button to exit. L.¥...

> Select the _$ide View from the view toolbar to see the arc.

2e@= T

> The part will look as shown to the right.

> Select the Isometric View from the view toolbar to see the arc. Eﬁ! &9

2@ 6@

> Click on the drop-down arrow next to the Set planes icon, and select the
Right plane.

1.7 Rotate-Copy the existing arc to create the other

Move Copy Join

arcs with the same radius. K ¢ e o
1 {3 Angle between
om0

Xform O Total

» Xform Rotate
> [ Select entities to rotate ]: Select all three arcs.

N @ |
> Click on the End Selection button. jEnd Scecton
> Make sure that you_make all the Select Define center / ‘ ;
changes as shown in the screenshot. B a2
> Enable the Copy radio button. Ly _.
> Change the # to 2. W[ Ren | [
» Change the Angle to 76 degrees. . Feicbuies
> Select Define center (point) of rotation as shown. _ [ Use New Atsbutes
> [ Select the point to rotate about ]: Select the Fast Point icon. A ER

> Enter into the box to the left of the icon: 0.2612,0

. (Enter).

> If the Preview is active you should be able to see the
result.

> Select the OK button to exit. L. ¥
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> See the part from the Side View as we did before.

—_

2 e@3 A

{
» Change the graphic view back to Isometric. L= e 9@'

» Click on the drop-down arrow next to the Set planes icon, and select the 4~ | Frontucs)

Right plane.
STEP 2

Top {WCS)

CREATE THE TWO ARCS KNOWING THREE POINTS.
2.1 Create points at the endpoints of the entities.

Create

» Point

» Create Point Endpoints

é* Note that the points are automatically created.

2.2 Create arcs knowing 3 points.

Point C

Create
> Arc

» Create Arc 3 Points '
» [ Enter the first point ]: Select Point

A Point B

> Enter the second point ]: Select
Point B. I

» [ Enter the third point ]. Select Point C.

> [ Enter the first point ]: Select Point D.
> [ Enter the second point ]: Select Point E.
> [ Enter the third point ]. Select Point F.

» Select the OK button. &

Screen Point D

» Clear colors

Point E

Point F
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STEP 3:
CREATE A NET SURFACE.

2 kNet Surface: a surface generated from a network of lntersectmg curves.
Applications: used to create a surface from a grid of curves. .

3.1 Join the arcs with 10” radius. T
Edit
> Join entities i
I Only.. Ll
> [ Select entities to join ]: Select the All button. l ---------- 4 g
> Select Entities and Arcs only. 0
|
o
E_‘:-_D \Wiehame
B e
&g&-l
3 ot
& [ Dishing
[ Soids
> Select the OK button to exit Select All. L.¥_ i
5 @ .
> Click on the End Selection button, L__[EdSdecton] Pt sk g
& 1 1 S [ Igrate daits in shairing
6" Note that arcs will be automatically joined.
[ Line Qi Masshe
3.2 Create the net surface. (El=lvIi]
Create '
> Surface

> Create Net Surface
> Click on the Chaining dialog box title bar to move it.

> Select the Apex Point from the Ribbon bar.
> Select the Window button in the Chaining dialog box.
> Make a big window around the entire geometry as shown below.

| Window
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» [Enter search point]: Select Point A Point A i
» Select the OK button to exit Chaining.

> Indicate the apex position ]: Select the Point A.

» Select the OK button to exit the command. @
» The part should look as shown in the screenshot to the
right.

» Change the construction plane back to Top.
» To shade the part you can hold down the Alt key and type S.

» Alt + S again will unshade the part.

STEP 4:
TRANSLATE THE GEOMETRY.

Xform
» Xform Translate
» [ Translate: select entities to translate ]: Select the All button.

FlENES

> Select the OK button. L.¥_J

> Click on the End Selection button.

1] e Doy Masl:

(a]=1v]?]
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> Make sure that you make all the changes as shown in the f o
screenshot. ol o
> Enable the Move radio button. W] © o o
> Enter Delta Y - 0.2612. .
» Select the OK button. |
h@;;;;i«?ﬁ;;;.ﬁ
STEP 5: Sl
CREATE THE BOX THAT WILL REPRESENT THE raraiEa
STOCK.
Create Bounding Box . &
> Create Bounding Box =N PlAlEnies
»> Enable Create, Lines Arcs and Center Point as shown in the 5 .
screenshot to the right. [stock
> Expand the stock with 0.375 along X and Y axis. . e
o . art
> Select the OK button to exit. L E-ﬂ:::m
| Dsan
STEP 6: £ i
SAVE THE FILE. o |
L Yjon @
File 2 @
> Save as w
> File name: “Your Name_10"
> Select the OK button. | )
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TOOLPATH CREATION

STEP 7:

SET UP THE STOCK TO BE MACHINED.

Machine type
> Mill
> Select Default.

> To display the Toolpaths Manager press Alt + O.

Toolpaths Saeen Art
Lathe » 1 CY\MCAMXZ2\CNC_MA

> Use the Fit icon to fit the drawing to the screen. @

» Select the plus in front of Properties to expand the Toolpaths

Group Properties.

> Select Stock setup.

Tl | ] M
FWIETA S T IR b
Qe and valbe | &
B G| Wt | z
Gt B P s it | ;
i (ke ”
I |
3 | *
& | ~
i |
5 |
[ |
B
=
@
ty
‘.'( 1R
& F || GulewctSO WCSTOP ThCplane TOP L
o v e o [ T s (i (ST <l i [53], T T
Toalpaths | Solids |
GUIRELE@ T2
Select the plus Naza@vats
: Machine Group 1
-4l Properties - Generc Mil
B &m
Toolpaths | Solds | =
GLHLIEP T P

i

AR val &

& B Machine Group1

Select the Stock

-1l Properties - Geneic Ml
5 Files
— B Tool settings
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» Change the parameters to match the screenshot to the right.
»> Select the Bounding box button to automatically find the part extents.

» Change allithe expand values to 0

> Select the OK button to exit the Bounding box dialog box. L

[¥] Drsplay
> Change the Z value of the stock to SR e
1.0 as shown. E e

* Stecke Origin

|~r oo

> Select the Tool Settings tab to set the tool
parameters.

» Change the parameters to match the screenshot
to the right.

> Select the OK butt

on to exit Toolpath Group

Properties.
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STEP 7:

ROUGH OUT THE SURFACE USING
SURFACE ROUGH

POCKET. Select the

surface

Toolpaths

> Surface Rough

> Rough Pocket Toolpath
> Select the OK button to accept the NC name.
» [ Select Drive Surfaces ]: Select the surface.

> Click on the End Selection button. ik

» Select the Containment button as shown. - Oiive
no &
hout
herk
:_-:;rulaw‘zrvva[;; @
» Enable Chain mode in the Chaining dialog box. s S
> Select the first entity of the chain as shown. A LB

Select the
first entity
here

Select the
second entity

» [ Select next branch ]: Select the second entity.
» Select the End chain button as shown in the dialog box.

» Select the OK button to exit Chaining. L%

> Select the OK button to exit Toolpath/surface selection.
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> Click on Select library tool in the Toolpaths parameters dialog box.

> Select the Filter button in the Tool Selection

dialog box.

> Select the None button
in the Tool Types area.

> Select the Bullnose tool
type button.

> Select the drop-down
arrow in the Tool
Diameter field, and
select Equal.

> Enter the Tool Diameter
0.25.

> Select the OK button to

Tool List Filter

Tool Types

exit. L.

.. Tool Dismeta
Clequal DS
e,
Comer Full
Tool Materal ———————— -supsmmsmeamsmnaimsmnn

HSS Ceramic
Carbide User Def 1
{¥] Ti Coated [] User Def 2

i [ All ] [ Maong ] [ Copy job setup matl ]

> Select 0.25” Bull Nose with 0.0625” corner radius in the Tool Selection page.

» Select the OK button to exit. L

> Make the necessary changes in the Toolpath parameters to match the following screenshot.

. Toalpath ¢

Number | Tool Type | Diametar Tool Name Comerrad
Endmil3..

v 02500.. 1/4BUL. 00625004

é* The Feed rate,
Plunge rate, Retract
rate and Spindle
speed are based on
the tool definition.
Change them as
desired.

0 (Toia ]

i Comment
e Hough out the par.

[[] Force tosl change: Rapid retract

] To batch
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> Select the Surface parameters tab and make the changes as shown.
enable Compensate to Inside, for the Tool containment.

Surface Rough Pocket

Make sure that you

iR;)ughr

|| Pocket parameters |

(Gesrance... | |10

® Absalute

> incremental

Stock to leave
drive

7) E o5 on
[ J ! l Stock to leave

) Apsolute (&) Incremental on check

T8 e

0:
O Apsoite @ incremental e L

Er

» Select the Rough

parameters page and
make the changes to

Surface Rough Pocket

match the following [ Toolpath parameters | Susface parameters | Fough p [Pocket p
screenshot. i)
[ Tatal tolerance... § 0.005
e
Madmum stepdawr: 008 ] Use entry poirt
[7] Plunge outside containment boundary
® Cmb (O Convertional [ Align plunge entries for start holes
Fl

Page
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> Select the Cut depths button and
enable Keep top cut at max
stepdown to force the system to cut
0.05 deep at the first pass.

» Select the OK button to exit Cut
Depths. &

¥

Cut Depths
s Absolute

Absolute depthis

SR UG]S

Relative to

ey canees NN

3 Incrementat

Incremental depths

Adjustment to other cuts

7] Auto-detect Hlats fwhen pracessing)

Detect flats ;
i

Critical depths...
Clear depths

ydires futlaces (Note: drive stock is included in adjustment )

8 v ][ %] ?]

> Enable and select the Entry-Helix button and make any necessary changes.

2 &

[Entry-helix sets the parameters for
a helical entry into the part. j
Minimum/Maximum radius value
sets the minimum/maximum radius

~ of the helix as a percentage of the

 tool diameter or as an absolute

value. :

- Z clearance value sets the dlstance

_in the Z-axis above the top of the

~ stock where the helix entry begins.

- XY clearance sets the minimum
distance in the XY axis between the
helix and the pocket walls. 1

 Plunge angle sets the helix angle.

 Output arc moves instructs the

- system to output circular movements

. gmstead of Ilnear movements.

Helix/Ramp Parameters

o . Dicsction -
ey ,50"*“: ! (m .............................. e ghl
Z clearance:
XY clearance:
Plunge angle:
- ¥ gl entry sttempts fal
[¥] Output are maves & Plunge O Skip
Eelronce E Save shipnod Satdare
 Erdry feed rata
AR | @Pungersts () Feadrate
(vI[%][ 2]

> Select the OK button to exit Helix Parameters.
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> Select the Pocket parameters and change the Cutting method to Parallel Spiral.

Surface Rough Pocket

Cofdam. @i

Stepover distance:

Aoughing angle:

[¥] Finish 0“’“ :__W |:|
Passes Spacing Spingpasses  Cutter compensation il s /
[ S I I O == Bl | Domdespeed 77 ]
[¥] Finish containment boundary : .

» Make sure that Spiral
inside to outside is selected.

> Select the OK button to exit. &

> Select the Toolpaths tab to enable the Toolpaths Manager.
> Select Toggle toolpath display on selected operation to
remove the toolpath display from the screen.

HiE Tagg display on selected operations

Page 10-17




Mastercam,

Mill X? TUTORIAL 10

STEP 8:

CLEANING THE AREA WHERE THE PREVIOUS TOOL DID NOT FIT
USING SURFACE ROUGH RESTMILL.

Toolpaths

> Surface Rough

> Rough Restmill Toolpath

> [ Select Drive Surface ]: Select the surface.

Select the surface

L
> Click on the End Selection button. E e

> Select the Containment button as shown.

ﬁmw stating poiet
»> Select the first entity of the chain as shown. :

Select the
o first entity
Select the here
second
entity here

> [ Select next branch ]: Select the second entity.
> Select the End chain button as shown in the dialog box.
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> Select the OK button to exit Chaining.

> Select the OK button to exit Toolpath/surface selection.

» Click on Select library tool in the Toolpaths parameters dialog box.

> Select the Filter button in the Tool Selection dialog box, and following the steps at page 10-
14 select the 0.125 Bull nose.

> Select the OK button to exit.

» Select 0.125” Bull Nose with .03125“ corner radius in the Tool Selection page.

» Select the OK button to exit.

» Make the necessary changes in the Toolpath parameters to match the following screenshot.

r

Surface Restmill

| Comer radius: DE;;SWW

e = sty g s
[ Number| Tool Type | Diameter  Tool Neme Comerrad Tool name: | 1/8 BULL ENDMILL 0.0313 RAD |
W 1 Endmid. 02500.. 1/4BUL. 00625004 = A
_ . Tool & |2 offset;

‘¥ 2 Edmi3. 01250 1/8BUL. 0031250 £ ::j LB“*"*E:._;}

; Head # [0 | Daofeet: 2 ]

i i r R " =S
| | Tool d: [0.125 ]

|

!

Feed rate: ;3-2'4523 Spindle speed: {4273

‘ Plunge rate: | Betract rate: {82-145233
. b e

[ Force toot change Rapid retract

—

r Eean'ng the remaining material that previous ool __«f-:
Right-click for options |oodd el 5 - A Eae N
|

Dl Tooi fiter | ]

[} Tobatch [¥] )}ny: FPlanes... ] FannedTen...]
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> Select the Surface
parameters tab and

make the changes as

shown.

] ’0'5 | Si:;(d::;ava E )
on check :
r? T : Taol cortainment
@lncremutal

lnerenental

raE3Ea)

> Select the Restmill parameters page and made the changes as shown.

of the arc filter tolerance
,and cut tolerance. The cut
tolerance determines the

[ Use apprcadmets st poct
[¥)Oplimize ey order

[] Minimize burial

[T rler cuts boftam 1o top
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> Select the Restmaterial parameters page to set the options to define how Mastercam
calculates remaining stock.

r

Surface Restmill

| Toolpath parameters | Surface pa

Compute remaining stack from: —

Machine Group-1

i Properties - Generic Mill
5 =88 Toolpath Group-1

] Use regen file w B e

{ Roughing toot

| 3 Al previous operaticns
@ i

{2 STLfile
Stack resolution 0025 |

Adpustimerds o remaining stock:
&) Usa remaining stock as computed
(3 Adjust remaining stock to ignore amall cusps
{3 Adiust remaining stock to mill smal cusps

o |

Compute remaining stock from One other operation calculates the remaining
stock based on the selected previous operation.

Stock resolution sets the amount the stock model is sampled, entered as a
distance. A smaller value tightens up the stock model and creates a more accurate
restmill toolpath.

> Select the OK button to exit. %.&i
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STEP 9:

FINISH THE SURFACE USING SURFACE FINISH BLEND.

> Select the Toolpaths tab to enable the Toolpaths Manager. Toolpaths | Soids |

> Select Toggle toolpath display on selected operation to e DR EDol P
remove the toolpath display from the screen. A rales

Toolpaths .

> Surface Finish

> Finish Blend Toolpath
> [ Select Drive Surface ]: Select the surface.

Select the surface

> Select the End Selection button. __
> Select the Blend button in the Toolpath/surface selection dialog box.
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> Select the first entity of the chain as shown.

Select the
first entity
here

Select the
second entity

> [ Select next branch ]: Select the second entity.

> Select the End chain button as shown in the dialog box to the right.

» Change the selection mode to Point in the Chaining dialog box.
» Select the Center point as shown in the picture below.

_— | Select this
point

> Select the OK button

to exit Chaining. L%
> Select the OK button to exit Toolpath/surface selection.

Bl Chaining
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» Click on Select library tool in the Toolpaths parameters dialog box.
» Using the Filter option select the 0.125 Ball Endmill.
> Make sure that you select the None button first and then the Endmill Sphere as the tool type.

Toul List Filter

ool Types 1 Tool Diametey -~
| — -
l — e —— i o
[ :~Radius Type —
¥ None ¥ Comer ¥ Ful
- Tool Materal — = s
¥ Hss ¥ Cetamic
: ¥ Catbide ¥ UserDef1
| DOpetation masking Unit masking I I TiCoated W UserDef2
| j?io Sperah Nask sr;gﬂj INo unit masking JJ ‘ A : Né_ng E Copy iob setup mat| i
] |

> Select the drop-down arrow in the Tool Diameter field, and select Equal.
» Enter the Tool Diameter 0.125.

» Select the OK button to exit.

» Make survevthat the tool is selected in the Tool Selection window and select the OK button to

exit. i
» Make any necessary changes as shown in the following screenshots.

Surface Finish Blend

Toolpath parameters | Surface elers | Finish blend p |

| Mumber Tool Type Dismeter| Tool Name Comerrad  Tool name: | 178 BALL ENDMILL |

@ 1 Endmi3.. 02500 1M4BUL. 0.062500H
| Tool #: (3 Len -13 :
@ 2 Endmi3. D1250. 1/8BUL.. DO31250 offset ;
¥ a3 TR

Endmil2 _ 01250, 1/8BAL. 0062500k Head# [0 ] ﬂﬁaoﬁset:[a

Tool dia: {0.125
Comerradius: |0.0625

[7] Foros tool change Rapid retrarct
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Surface Finish Blend

i; o

(® fbsohte ) Incremental

e o

Stocktoleave [pg
on check L«m«-mm—] 3

Toot cartainment

Blend finish toolpath

drives the toolpath | (o] Dot |
along the surfaces :
using a pattern created Mo [005 ]
from curves that mimic Guttingmethod:  [Zigzag )

the part features.
'Blend along settings
_dialog box provides
. eomrol over the

.....

O Across @ Mong
O ® 30

created by the along

and across tool moves
of the Project blend
;toolpafh .
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> Select the OK button to exit Finish blend parameters. | |

STEP 10:

BACKPLOT THE TOOLPATH.

» Click on the Toolpaths tab to enable Toolpaths Manager.
Toopaths |Soids |
W R EP ot

» Choose the Select all operations icon to select all operations [ostalowesioh & &

> Select the Backplot selected operations button.

> Make sure that you have the following buttons turned on (they will appear pushed down).

Display tool
Display rapid moves

Display tool

(&]
(v ]1[2]

Display rapid moves
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> Select the Play button.

» Select the OK button to exit
Backplot. LY.

STEP 11:
VERIFY-TOOLPATH VERIFICATION

Moves/step: 1 J
Moves/ishesh: ﬁ&_ﬂﬂﬂ E
= [ o tuewy
> Make sure that Turbo button and Stop on collision are enabled. s e g g
; ;..Updale'aﬂareu:h toolpath
e —
[ Stop on tool changs
["]Stop after sach operation
g
#] (] [ &)
m —3
Toclpalh  Suface Frish Blend
. Todl#t
i Tadkbd
A EIAER
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» Select the Configure button. @

Verify Options

i Stock
- ;Q; . o . Shape Boundaries Minpoint. ~ Max point.  Margine:
Initial stock size source  ®Box [ Somwpwrn ] x[01 ot Joo ]
should be set to Job Setup - O Cylnder ¥ ; |
. : OFile l Use Stock Setup values ] Y 2125 §2'125 j 00 3
to use the stock information & sosd \ i % —
from StOCk Setup. I ] [ Pick stack corners... ] z 05 igﬂ.ﬂ e !
Use True Solid allows you, b e floin b WA e =
after verifying the part, to R jeempdly 4 resseE
fOtate and magnlfy It tO {i} Use last size a2 s e
more closely check B
features, surface finish, or Stockils - | . j | I T HTiasicsnl stock
S?a“OpS. . . Mizcellansous options : Tool pofile
Change tool/color to [ Use TrueSoid O Auto
change the color of the cut oy (5 s defined
stock to indicated tool . [ Display XYZ axes
changes in the toolpath. [ Compare to STL. fie
I [CJ Remova chips T ool tolerance: iUUQB
[¥liChange tool/colof . .
["] Hide taol at each stop ol e e
[T Make tre threads
v ][ 8] 2]

e — — —_— i

» Select the OK button to exit Verify Options. i

> Set the Verify speed by moving the slider bar in the speed control bar.

» Select the Machine button to start simulation. }
» The finished part should appear as shown in the following picture.

> Select t_e OK button to exit
Verify. LY
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STEP 12:
POST PROCESS THE FILE.

» Select the Post selected operations button from Toolpath Manager.

Past processing

> In the Post processing window, make all the necessary
changes as shown to the right.

MEFAN FET

] Outpest MK filw: descrptor i
NEHB M
N 7 ) Overwite [v] Edit
ALX @Ask NC edtension: |
- NC file enabled allows you to keep the NC file and to [ f :
~ assign the same name as the MCX file. [] Send to machine
- Edit enabled allows you to automatlcally launch the
default editor. FLAnes s
- Dlutpi Tplaes

Telative o LS

(vi%]) 2]

> Select the OK button to continue. t-¥_|
» Enter the same name as the geometry name in the NC File
name field.

> Select the Save button. “Hdemom
@g Fie pan T YOUR AME_ 10l e _:J I am ;
w\’cﬁxxar Save s iyme; 7 INC Fles {'nc) = Caccm }
Ay
il
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v RS BEEODSARAITZEFE P NS MY PEFes 4%%%
W Mok Al Tod Crerges @) HextTool &) Soto Frevous Todl

YOUR ME4E_10 )

Ir 12-08-0¢ TIIDMReRTof i1:81 )

ot Liman

0 G0 G54 X-.5274 r-.207# AD.

e
o
W o

Wil ol
W43 oF X1.5357 K
%-1.3338 ®

¥ 1807 WY,
¥0. 9. HE0H
¥3€ ¥.0002

k

> Select the red X box at the upper right corner to exit the Editor.

STEP 13:
SAVE THE UPDATED MCX FILE.

» Select the Save icon.

e ire: thi2 M | SHASE00A | L1
M L L L

E

=
%
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REVIEW EXERCISES.

Student practise. Create the Toolpath for Exercise-Tutorial
10 as per the instructions below:

& Tips:

1. Establish the stock using Bounding box and
change the stock size to X =3.75,

Y =3.75",and z = 2“ (Stock Origin X= 2.0, Y= 2.0,

Z=0.05)

2. Surface Rough Pocket

Select the net surface

Select the buttom rectangle as Tool Containment

boundary

Use 3/4" Bull End Mill rad 1/4

Stock to leave on drive surfaces= 0.03"

Total tolerance = 0.01

Max stepdown =0.1

Disable Entry

Enable Plunge outside tool containment

Cutting method quick zigzag

2. Surface Finish Blend

Select the net surface

Select (in the same direction) the two arcs as the
blend curves as shown

Use 3/8“ Ball End Mill

Stock to leave on drive surfaces= 0
Total tolerance= .001

Maximum stepover= 0.05

Cutting method zigzag and along

3. Backplot and Verify the toolpaths.
4. Post process the file.
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Objectives:
The Student will design a 3-dimensional drawing by:

> Creating rectangles using co-ordinate positioning.

» Creating parallel lines

» Creating lines knowing the endpoints.

» Creating fillet radii.

» Changing the construction plane to Side and creating half of a rectangular shape and half of a
hexagon.

> Defining a plane from entities.

> Creating an arc polar knowing the center location.

> Creating a swept surface.

> Changing the view of the part for better visualisation.

The Student will create a 3-dimensional milling toolpath consisting of:

» A 3-dimensional rough toolpath.
> A 3-dimensional finish toolpath.

The Student will check the toolpath using Mastercam’s Verify module by:

> Defining a 3-dimensional block, the size of the workpiece.
» Running the Verify function to machine the part on the screen.
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GEOMETRY CREATION

To start a new file from Mastercam:

File

> New

é* Before starting the geometry creation we should customize the toolbars to see the toolbars
required to create the geometry and machine a 2D part. See Getting started page A-5 in
the User Notes.

é“ Toolpaths/Solids manager to the left of the screen can be hidden to gain more space in
the graphic area for design. Press Alt + O to remove it.

¢ Before starting the geometry make sure that the Grid is enabled. It will show you at each
moment where the part origin is. See Getting started page A-5 for details.

STEP 1:
CREATE THE BOX WIREFRAME.

1.1 Create a rectangle.
Create
» Create Rectangle

» Enter the Width 4.Q (Tab).
» Enter the Height 4.0 (Enter).

» Enable Anchor to center.
> [Select position of first corner]: Select the Origin (center
of the grid) as shown.

Select the il
Origin |

> Select the OK button. B

é* During the geometry creation of this tutorial, if you make a mistake, to undo the last step you
can use the Undo icon. You can undo as many steps as needed. =

é* If you delete or undo a step by mistake, just use the Redo icon. ©*
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1.2 Create the 3d box using translate command.

Xform
> Xform Translate

> [ Select entities to translate ]: Hold down the Shift key and
select Entity A as shown.

Select Entity A Ll

é* Note that all four lines of the rectangle Lot
are selected.

2R @

» Select the End Selection button. [___[ExfSsedten

Translate

Move  Copy Jomn
R ©o ¢ e
» Change the parameters in the Translate dialog box as shown to the ol Wi W

right. -
Delta =
» Make sure that the Z value is -1.0 and Join is enabled. &K 00
S 00 W

 [#}] Regen il

Altributes

» Select the OK button to exit. L¥_] .
[ tise Mew Attributes |
» Change the graphic view to Isometric. *E De @@ (v 2]

> Use the Fit icon to fit the drawing to the screen. @

Screen
> Clear colors
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STEP 2:
CREATE THE WIREFRAME IN THE TOP CONSTRUCTION PLANE.

I | £y
» Change the graphic view to back to Top. }@@ 5 E

r%
> Select 3D from the status bar. The system will automatically switch to 2D. | [ Gien_|planes |

2.1 Create parallel lines.
Create
» Line

> Create Line Parallel

> [ Select a line ]: Select Entity A. Entity D T

> [ Select the point to place a parallel line
through ]: Pick to the right of the selected line.

> Type the Distance [F[ 1.0 (Enter). Entity A \\ T
Entity B N
y \\
Fd

Entity C /
é* Note that the color of the geometry is cyan. This means that the

entity is “alive” and you can still change the line parameters. To exit the command you can
either start a new command or select the OK button. X

> To create more parallel lines with the same distance click on the distance icon. The distance

value will be highlighted in red.
> [ Select a line ]. Select Entity B.
> [ Select the point to place a parallel line through ]: Pick a point above the selected line.

> [ Select a line ]: Select Entity C.
> [ Select the point to place a parallel line through ]: Pick a point to the left of the selected line.

» [ Select a line ]: Select Entity D.

> [ Select the point to place a parallel line through ]: Pick a point
below the selected line.

> Select the OK button to exit. &

» The part should look as shown to the right.
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2.2 Create a line knowing the endpoints.
Create

» Line

> Create Line Endpoint Select L ===
> [ Specify the first endpoint ]: Select Point A. Point A b g o
> [ Specify the second endpoint ]: Select Point B. s
é* Make sure that this Intersection mouse icon is on

=
when you select the points."H=’ o Select s il
. v Point B

» Select the OK button to exit the command. &
2.3 Create the fillets.
Create
> Filet Select Entity B here | ~
> Fillet Entities RS B
» Enter the Radius &% 1. |

(Enter). &%

Select Entity A here =T .

> [ Select an entity ]: Select Entity A.

> [ Select another entity ]: Select Entity B.
> [ Select an entity ]: Select Entity B. Select Entity C here
> [ Select another entity ]: Select Entity C.

> Select the OK button. &

2.4 Delete the construction lines.
> Select the lines as shown to the right. Delete
| these lines

> Select the Delete entity icon.
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STEP 3:
CREATE THE WIREFRAME IN THE SIDE CONSTRUCTION PLANE.

> Change the graphic view to Isometric. _E D e @@|

> For a better view of the part hold down Alt and click twice on the left cursor key.
> The part should look as shown to the right.

> Click on the drop-down arrow next to the Set planes icon, and select the
Right plane.

> Select 2D from the Status bar. The system will automatically switch to 3D.

3.1 Create the rectangular shape.

Create

> Create Rectangular Shapes

> Type the Width and the Height as shown in the screenshot to the
right.

Select the double
arrow to expand

> Select the radio button as shown.

Select this radio button

Cufecd  Dltetsrpont
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> [ Select position of base point ]: Select the endpoint of the line as shown.

Select this Endpoint S / Y 7] \
.//'|I ’
. R

> Select the OK button to exit the 3 N
Rectangular Shapes Options dialog v

box. -

3.2 Delete the extra line.
> Select the line as shown to
the right. Delete this line ~
> Select the Delete entity icon. &
" Make sure that you only delete the line from the
rectangle.
EXIE
> Select the Repaint icon. I Repant

r"II,‘FuII

3.3 Create the hexagon.

Create

> Create Polygon

» Change the number # of sides to 6.

> Enter the Radius value.

» Enable Corner for the system to measure the radius to the corner
of the polygon.

\‘) Comer 7 Flat
> [ Select position of base point ]: Select the endpoint of the line as :

shown in the following screenshot. B0 -

\
7

> Select the OK button‘to eX|t the
Polygon dialog box.

Select the endpoint here
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3.4 Delete the extra lines.
> Select the line as shown to the right.

> Select the Delete entity icon &

Delete these lines

3.5 Create the fillets.
Create
> Filet
> Fillet Entities Select Entity A

» Enter the Radius @ 0.25.

> [ Select an entity }: Select Entity A.

> [ Select another entity ]: Select Entity Select Entity C
B.

Select Entity B

> [ Select an entity ]: Select Entity B.
> [ Select another entity }: Select Entity C.

> [ Select an entity ]. Select Entity D.
> [ Select another entity ]: Select Entity E.

> [ Select an entity ]: Select Entity E.
> [ Select another entity ]: Select Entity F.

» Select the OK button. >
ele
STEP 4: Entity D Vi

CREATE THE WIREFRAME IN A EntiyE | [ Solect,
USER-DEFINED CONSTRUCTION PLANE.

4.1 Create the second construction line to define the plane.
Create

> Line

> Create Line Endpoint
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> [ Specify the first endpoint ]: Select Point A.
> [ Specify the second endpoint ]: Select Point B.

™
é* Make sure that this Endpoint icon is on when you select the points]‘{_

Select Point A
Select Point B
» Select the OK button.
4.2 Define a new construction plane using 2 lines. @r|e-e-7]
> Select the drop-down arrow next to the Set plane icon and select from the :::f;]
list Planes by geometry. Al

R ucs)
> [ Select a flat entity, 2 lines, or 3 points I: =i

R Piares by sold face

> Select first Entity A as shown.
> Select Entity B.

Entity A

Entity B

> Make sure that the axes are orientated as shown.
Otherwise select the right-hand arrow.

> Select the OK button to accept it.
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» In the Name field enter Arc view. Hew View
> Disable Set new origin F,_‘T’_T? g piE Malevama . 1L
ARCVIEW i
» Select the OK button to exit. [ - ; | ’
Origin (in view coordinates; o
X2.82842712Y1, 20, § Set asWCS
_ﬁ lAssociaive  [lpetpowong o ]rx H ? |

4.3 Create an arc polar
knowing the center location, initial and final angles.

Create
> Arc
> Create Arc Polar

» Enter the Radius 0.5.

é* To set the other parameters of the arc use the Tab key. Note that the diameter value is
automatically changed by the system based on the radius.

> Enter the Start Angle =1 180 (Tab).

» Enter the End Angle =¥ Q (Enter).
> [ Enter the center point ]: Select the center
point at the midpoint of the line as shown in

the picture to the right. N /

Select the midpoint here

N N

é* The mouse icon for midpoint

f

]‘-l-
should be on. E

» Select the OK button to exit the command. 'ﬂ
» The wireframe should look as shown.

STEP 5:
CREATE THE SWEPT SURFACE

L XSwept Surface: a surface generated by translating or rotatingfr;:ﬁé" or more contours
(across contours) along one or two other contours (along contours). i
~ Applications: used when the across section of the surface at any point is cons

Page 11-11




Mastercam

Mill X?

TUTORIAL 11

Create

> Surface

> Create Swept Surfaces

> Make sure that Chain is enabled.

> [ Define the across contour(s) 1 ]: Select Chain 1 as shown.

> [ Define the across contour(s) 2 ]: Select Chain 2.

> [ Define the across contour(s) 3 ]: Select Chain 3.

¢ Select all the chains in the same directions. Use the Reverse

button from the Chaining dialog box if you need it. g 7

Define the across contous] 1

Select
Chain 1
here
Select
Chain 2
here RS Select
S Chain 3
here

> Select the OK button to exit across contour chaining.
> [ Define the along contour(s) 1 ]: Select Chain 1 as shown.

Diefire the siong conbouwa) 1

Select
Chain 1
here

> Select the OK button to exit chaining along contour chaining. L% ]
> Select the OK button from the ribbon bar to complete surface swept

i

creation.

?f'_f Chaining

F] .|

OCplme @33
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» Change the Construction plane to Top. | Bl &-@-| &
[@ mowesy

o~ 5 hOwes)
AT e -

STEP 6:

SAVE THE FILE.

File

> Save as

> File name: “Your Name_11"

> Select the OK button.
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TOOLPATH CREATION
STEP 7:
SET UP THE STOCK TO BE MACHINED.

'Qal\:i“me type Toolpaths  Screen Aﬂ

> Select Default. ﬂP
> To display the Toolpaths Manager press Alt + O. Lathe b, 1 COMCAMCAONG MA

K
L b i)
s }
\?l‘_% b
(i h X
i i
8 [
g
iy 12}
= -
L
b
-
"
L
Iy
L"! . TERS
A TS i | Gviewtso wesiTOR T Inch
e o Tm [Seen e (B[00 :i.'\-,;n-r.h @X&&;’g.. | | s 4 S B |

> Use the Fit icon to fit the drawing to the screen.
> Select the plus in front of Properties to expand the Toolpaths
Group Properties. Toolpaths { Soids |

VAL S

Select the plus

> Select Stock setup.

Select the Stock
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»> Change the parameters to match the following screenshot.

> Select Bounding box button to automatically find the part extents.

> Select the OK button to exit Bounding box dialog box.

e

| Fies_| Tool Setings | Sivck Setup | Satety Zova

> Select the Tool Settings tab to set the tool i —
parameters. \

Tockuth Canfiguraton
[¥#] Asmr taoi ruiens secuartialy
[¥] Warn of Auplicate tool numbers.

] v srof's st peche. coulunt
ns-mww:nm

> Select the OK

Properties. i

button to exit Toolpath Group
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STEP 7:
ROUGH OUT THE SURFACE USING SURFACE ROUGH FLOWLINE.

' creatmg an exact, smooth finish. You can only use flowline toolpaths on one surface or a
row of adjacent drive surfaces -

Toolpaths

> Surface Rough

> Rough Flowline Toolpath
> Select Cavity.

> Select the OK button to exit. L.¥__

> Select the OK button to accept the NC name.
> [ Select Drive Surface ]: Select the surface.

Select the surface

P (@

> Select the End Selection button, |__ [Exseecion]

} (0}
> Select the OK button to exit Toolpath/surface selection. - -
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> Click on the Select library tool button.

> Select the Filter button in the Tool Selection dialog box and select 3/8 Bull Nose with 0.125

corner radius. ( See tutorial 9 page 8-15)

Make the necessary changes in the Toolpath parameters to match the screenshot to the right.

Surface Rough Flowline

"

X

é“ The Feed rate, Plunge
rate, Retract rate and
Spindle speed are
based on the tool
definition. Change them
as desired.

e |

el
Fight-click for optiona

Tool name: | 38 BULL ENDMILL 8.125 RAT 1

[7] Force tool change Rapid retract

Commert
Roughing the part.

1| Toofiter l

[Emee] O

©l (ooger] O

[ Panes.. | [CamedTexiJ

(vI(%])(Z]

> Select the Surface parameters tab and make the changes as shown.

Surface Rough Flowline

stz and end of opetatian
@ E ______ | Stock toleave |pg
O Absolte () Incremental on check Lo—
feedplane. . | 025 |~ Tool containment ————
T 2T Coppemiside b ]
o e © = Inmde % Cortar Cusein
Abaciude crementsi o

{recticr

........
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> Select the Rough flowline parameters page and make the changes to match the following

screenshot. -
Surface Rough Flowline
|}o_nﬂmh jSudwe ........ | Rwﬁma parameters ] m
Cut contral Stepover control
[ Distance oM (%) Distance 01875
(Tl tolerance.. ) [0005 | | © scatop height l__l_ L
[#] Check fiowline metion for gouge
Max stepdown: 01 ]
Plunge control
@ Mow multiple plunges slong cut [#] Allow negative Z motion along suface
. ) Cut from one side [¥] Allow positive Z motion along surface
) Cut from both sides
Bmat T (Cigon.]  [Gepstings.] [Avencpdsstings ]
> Select the Total

A
e

\\\\\\\\\\\\

nnnnn

\\\\\\\\\\\\\\\\\\\\\

_J Dlorewsyiteing
T =

' [#] Create arcs in XY
[7] Creale 404 inX2
[2] Creats arcs inYZ

tolerance button and set the filter ratio to 2:1.
» Change the total tolerance value to .005.

> Select the OK button to exit. L%
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> Select the Gap settings button and change the Gap size as
shown.

Gap settings sets the way in which the tool moves
between gaps or spaces in a surface toolpath.

> Select the OK button twice to exit the parameter pages. .

> Select the Cut Direction button to toggle between along and
across direction of cutting. The flowlines should look as shown in
the following picture (along).

» Select the OK button to exit Flowline data. L

TUTORIAL 11

Gap settings

Gap sies
s Distance

(&3 % of stepover

Mabr < Gap size, keep tool down

: Broken v

{1 Use plunge, retract rate in gap

[} Check gap mation for gouge
Motion > Gap size, retracy

¥} Check retract motion for gouge
] Optimize cut order

P B e o s

. ih i coelan et Bol s 21 gah

Tangsntial arc radius: (00

Tangential arc angle:

Tangential line length:
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STEP 8:
FINISH THE SURFACE USING SURFACE FINISH FLOWLINE.

> Select the Toolpaths Manager tab to enable it. A Rl El@lcl] P
> Select the Select all visible operations button. vﬂv{(! %/t El@lcii| !

Wﬁvsdecl all visible operations |'¢:J
| %

> Select Toggle toolpath display on selected operations to Todipaths | Solds |
remove the toolpaths display from the screen. vl B% Ei®|cil¥]| 2|

8l%/a] vlalsls]

= B8[Toggle togbaﬂ'w display on selected opera

tions.

Toolpaths

> Surface Finish

» Finish Flowline Toolpath
> [ Select Drive Surface ]: Select the Select the

Surface. surface

> Select the End Selection button. Dive ——
W ® |
> Select the OK button to exit Toolpath/surface selection. !
Chexk.
o & [ & |
Show...
Caritainrient <7
> Click on the Select library tool button. t i
» Using the Filter option select the 0.25 Ball Endmill. S
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> Make any necessary changes as shown in the following screenshots.

Surface Finish Flowline

s
@ 1 Endmi3. 03750, 3/BBUL. 01250004
%‘l 2 Endmii2.. 02500 1/4BAL. 01250004
Plunge rate: _‘641?5 | Retract rate: 16.4176 2
[[] Force tool change ] Rapid retract
45 i Al e —
s " Fimishthe partt 5
Right-click for options
Select lbmary toal, M Toolfmer! ‘ ««««J'
| Oltosaen O [famen | [Peee ] [(Coedter]
(v][%][ 2]

> Select Finish flowline parameters and make the following changes.

Surface Finish Flowline

| Toolpath parameters | Sufacs parameters | Finish flowiine paramters |
Cust control Stepover control
iz Py
[_Totaltolerance.. ] [0001 | | | @ Scalop height
[¥] Check flowiine mation for gouge "

(vI[%][ 2]
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> Select the Total tolerance button and set the Filter ratio to
2:1, maintaining the Total tolerance at 0.001.

Filter ratio

Filter tolerance

Cut tolerance 0.000333 !

Total tolerance [O.UDT
] One way fitteting
Create arcs in XY

Create arcs in %2
. [viCreate arcs in YZ

. Minimum arc radius

» Select the OK button to exit Total tolerance settings.
» Select the OK button to exit Finish flowline parameters.

(v ][ % ][ 2]
»> Select the Cut Direction button to toggle between along and
across direction of cutting. The flowlines should look as shown in the following picture (along).

- Mavimum arc radius 1 J

» Select the OK button to exit
Flowline data L_¥__
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STEP 9:

BACKPLOT THE TOOLPATH.

> Enable Toolpath Manager. Toopaths | Salits |

> Click on the Select all visible operations icon in the
Toolpaths Manager to select all operations.

Toolpaths iSD]ids o _

> Select the Backplot selected operations button. Al 's‘»iﬁ’ximﬂgjglj?y{g_j_"_i

> Make sure that you have the following buttons turned on (they |=lE] w|abcgorseced serators
will appear pushed down). =

» Display tool

> Display rapid moves £ Backplot

Display tool

Display rapid moves

Select the Play button
| oIP]

> Select the OK button to exit

Backplot.
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STEP 10: S——
VE RI FY. M ‘__LE'EJ E_Igjcﬂ Y,QI_J |

> Select the Verify selected operations button.

» Select Turbo mode as shown.

> Select the Configure button.

e |

Initial stock size source
should be set to Job Setup to
use the stock mformatton from
Stock Setup.
Use True Solld allows you
,after verifying the part, to
rotate and magnify the partto

~more closely check featu{es

-surface finish, or scallops.

- Change tool/color to change

 indicated tool changes in the
 toolpath. .

the color of the cut stock to -

> Select the OK button to exit
Verify Options. 1

Bzl VIA[MMH'@

Spend _3_ Quety

[ Updale alter each toalpathy

Sap notans

[ iop oo eclisari

{1 51ap on ool change
1] 5ip alter sach roaratin

D‘\rm
.. ”““"“““3 l

Tuubdlt MFMM
Tool it
Tooliabet

) e Mepon: Mapot Magne
Zz{afgdh [ Scantoopatis) | x}}za |20 |iu.u
ém | LUse Stock Setup values I ¥ |-?_CI | iE.[] HD-D
Osdd i Plick stock cothas... ] 2z |-1.U | ED.U |iD.D ‘
ik slock g8 exace Ciricer e
O Scan toclpathis) X Cyltiter dissiate: (50
O Sipek bt { v Letial or) aas .
| O Use last size z -
Strae i [ 1 | [ Translucent stock
Mizcallareous aptions Tool prafite
. } Set golors...
S Er=s
+ %] Cutter comg in control *l A ifetined
[ 1 Diaplay XYZ awes
[ Compase to ST fie
. [ Remove chips T ool toletance: 'ana |
 [#]Changa toolizsiod Tora oo |
S {1 Hide took at aach shop
- 1 Make e hieade
(e ] [V ] [__] (2]
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& il

> Set the Verify speed by moving the slider bar in the speed control bar.

> Select the Machine button to start simulation. 4
> The finished part should appear as shown to the right.

> Select the OK button to exit Verify. L.X_|

STEP 11:
POST PROCESS THE FILE.

Todlpaths gSQHds I

> Select the Post selected operations button from *‘LM 4| %/% Ei@lc Gu‘?‘] 2 |
Toolpath Manager. EE Vi*f"—'»'i Potseleced operators]

> In the Post processing window, make all the necessary changes
as shown to the right.

{7 Dutput MCX file descriptor kil

» Select the OK button to continue. £.5

[ NC e -
- (& Qvenaite {ri Edit
£ Ask NC egtension;
: NC
[ — e
[ISend to machine | i atamend ||
[] N3 e o
" Civatreh ¢ tx
K ' Thabpiisa Tiharme
relin e ST

> Enter the same name as the geometry name in the NC File name
field. vk

» Select the Save button.

T —
My Computer  Havi e s |N.'.1en('ne) _-j i
]
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N4l X-.0844 ¥-.4447 pA.4717
N4 51 X-.5613 T-.554

545 62 X-1.474 Y-1.205¢ R

547 X-Z. Y-1.2873 W

®49 =1 X-2.0008 ¥-1,2857

HS1 63 X-1.336E ¥-1.2727 Rié.a
W33 %-.5093 ¥-.5655 R

NS5 82 X.%684 ¥.3004 Mg
N57 X.573 ¥.5454 RE.58
N38 X1.4%45 ¥.£438 ¥
83 X2.0005 ¥.6251
X2.001 Y.716%
X1.333 ¥.738 W
X.7888 ¥.4853 n,
-5769 ¥-.879€ Rl
483 Y-
T ¥-1.2589 1
1 X-2.001 ¥-1.1053
63 x-1.2873 ¥-1.1835 R7.8848
X=- 5282 ¥-.7327 Wi.1834

G2 X.8501 ¥.£547 mil
*1._4

o

Vo Kb

(8

...
¥

K
|
[
o
o
o

> Select the red X box at the upper right corner to exit the Editor.

STEP 12:
SAVE THE UPDATED MCX FILE.

> Select the Save icon.
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TUTORIAL 11 - EXERCISE

ALUMINUM T&0s1

DATE: JINE 12, 2000

TITLE
MTERIAL




Mill X*

Mastercam.

TUTORIAL 11

REVIEW EXERCISE.

Student practise. Create the Toolpath for Exercise-
Tutorial 11 as per the instructions below;

& Tips:
1. Establish the Stock size Y =7, X=10,Z =
25
Stock origin X=-525,Y=-1,Z2=2
2. Create a rectangle with surface option at Z0,
the same size as the stock.
3. Surface Rough Pocket
Select all surfaces
Chain the bottom rectangle for tool containment
Use 1“ Bull End Mill rad 1/4
Stock to leave on drive surfaces= 0.05"

Total tolerance = 0.01

Max stepdown =0.1

Disable Entry

Plunge outside tool containment

Cutting method quick zigzag

Disable finish containment boundary

4. Surface Finish Flowline

Select only the “sweep” surface. Flowline
toolpath can only machine surfaces that form a
row.

Use 1/2“ Ball End Mill

Stock to leave on drive surfaces= 0

Filter ratio 2:1

Total tolerance= .002

Scallop height =.002

Cutting method zigzag

Flip options: Cut direction “along Y-axis”as shown
above.

5. Backplot and Verify the toolpaths.

6. Post process the file.

Page 11-27







